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Before you Install
MapInfo Professional® is a comprehensive computer mapping tool that enables 
you to perform complex geographic analysis such as redistricting, accessing 
your remote data, dragging and dropping map objects into your applications, 
creating thematic maps that emphasize patterns in your data, and much more.

This document describes how to install MapInfo Professional to your desktop. It 
also provides more advanced topics that an IT Specialist or System Administer 
would follow for installing MapInfo Professional within an organization.

For information about how to work with MapInfo Professional, see the MapInfo 
Professional User Guide after installing MapInfo Professional.

Topics in this Section:

Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7
System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8
MapInfo Professional Database Connectivity and Support . . . . . .9
MapInfo Professional Data File Support  . . . . . . . . . . . . . . . . . . . .11
MapInfo Professional Web Server Support . . . . . . . . . . . . . . . . . .14
Before You Install MapInfo Professional . . . . . . . . . . . . . . . . . . . .14
Citrix Installations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .16
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Introduction
Introduction
This document is organized in two parts. The first provides information and instructions necessary 
for installing MapInfo Professional to a user’s desktop. The second, titled Advanced Topics for 
System Administrators, provides information and instructions necessary to IT Specialists or 
system administrators who must install MapInfo Professional in an organization.

MapInfo Professional Users

To install MapInfo Professional on your desktop:

1. Review the information in this chapter: 
• System Requirements, 
• MapInfo Professional Database Connectivity and Support on page 9, and
• Before You Install MapInfo Professional.

2. Follow the instructions in Chapter 2: Installing MapInfo Professional.

To remove MapInfo Professional from your desktop, see Modifying or Removing MapInfo 
Professional on page 25.

IT Specialists or System Administrators

System administrators installing MapInfo Professional should refer to the chapters in the second part 
of this document, see Advanced Topics for System Administrators on page 45, which contains 
information for installing a workgroup, performing a silent installation, and advanced configuration 
options.
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System Requirements
System Requirements
Below are the guidelines for minimum and recommended system requirements. Note that hardware 
requirements do vary based on your use of the product and your system. In general, a higher 
processor speed, larger memory (RAM) and industry leading graphics cards provide a better user 
experience and result in better responses from MapInfo Professional. These are the minimum 
system requirements for MapInfo Professional 11.0: 

These are the recommended system requirements for MapInfo Professional 11.0:

MapInfo Professional supports the following Microsoft Windows Desktop Operating Systems: 

• Windows XP Professional 32-bit Service Pack 3 (SP3)
• Windows 7 Ultimate 32-bit SP1
• Windows 7 Ultimate 64-bit SP1 with 32-bit compatibility mode

Operating Systems  Memory Disk Space Graphics  Monitor

• Windows XP Professional 
32-bit SP3

• Windows 7 Ultimate 32-bit SP1
• Windows 7 Ultimate 64-bit SP1 

with 32-bit compatibility mode

512MB RAM with a 
1GHz Pentium 
processor (2GB RAM 
and 1.8GHz 
processor 
recommended)

1.5GB or better

(2GB 
recommended)

16- or 24-
bit Color 

1024x768 
resolution 
or better

• Windows 2008 Server 32-bit 
SP2

• Windows 2008 Server 32-bit 
SP2 with XenServer

• Windows 2008 Server R2 
64-bit SP1

512MB RAM with a 
1GHz Pentium 
processor (2GB RAM 
and 1.8GHz 
processor 
recommended)

2.9GB 16- or 24-
bit Color

1024x768 
resolution 
or better

Operating Systems  Memory  Disk Space  Graphics  Monitor

• Windows XP Professional 
32-bit SP3

• Windows 7 Ultimate 32-bit SP1
• Windows 7 Ultimate 64-bit SP1 

with 32-bit compatibility mode

512MB RAM with 
a 1GHz Pentium 
processor 
(2GB RAM and 
1.8GHz processor 
recommended)

Fast EIDE 2 or 
SCSI Interface 
with 2GB or 
better

Data 2.3GB

Mid to High 2D/3D 
card with 128 MB 
or better

1024x768 
resolution 
or better

• Windows 2008 Server 32-bit 
SP2

• Windows 2008 Server 32-bit 
SP2 with XenServer

• Windows 2008 Server R2 
64-bit SP1

Same, PLUS 
memory sufficient 
to support each 
connected user

Fast EIDE 2 or 
SCSI Interface 
with 2GB or 
better

Data 2.3GB

Server: Same

Client: Choose 
based on 
resolution/speed 
requirements

1024x768 
resolution 
or better
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• Windows 2008 Server 32-bit SP2
• Windows 2008 Server 32-bit SP2 with XenServer
• Windows 2008 Server R2 64-bit SP1

There are no special installation instructions for installing MapInfo Professional on a 64-bit 
Windows Operating System.

Dependencies and Prerequisites
The MapInfo Professional install wizard checks for the following and prompts you if not already on 
your system; you can choose to have the install wizard install these requirements, or cancel the 
installation if you do not want to proceed. Installing the prerequisites takes several minutes.

• Microsoft Office Access database engine 2010—does not install when the 64 bit office 2010 
driver is installed

• Microsoft Office Access database engine 2007—only on a 64 bit Operating System that has the 
64 bit 2010 driver installed

• Microsoft Visual C++ 2010 SP1 Redistributable Package (x86)
• Microsoft .NET Framework 4.0 Full
• Hotfix for Microsoft .NET Framework 4 Client Profile (KB2484832)
• Hotfix for Microsoft .NET Framework 4 Client Profile (KB2498911)

Check the Microsoft website for the minimum requirements for these redistributables and 
updates if installing to an unsupported operating system.

MapInfo Professional installs a file from the Microsoft Windows Presentation Foundation (WPF) 
toolkit, WPFToolkit.dll file version 3.5, which is necessary for the MetaData Catalog Browser feature.

VisualStudio 2010 Users

If you have VisualStudio 2010 on your computer, you may see a prompt to install the Visual C++ 
2010 SP1 Redistributable files when installing MapInfo Professional. This does not alter any existing 
files for Visual Studio 2010, it only adds an additional file named msdia100.dll to the computer. You 
can uninstall either VisualStudio 2010 or the Visual C++ 2010 SP1Redistributable without negatively 
affecting the other.

MapInfo Professional Database Connectivity and Support
MapInfo Professional supports the following spatial database servers: 

• Microsoft SQL Server 2005 with SpatialWare 4.9
• Microsoft SQL Server 2008 (also called SQL Server Spatial)
• Oracle Spatial 11G, 10Gr2
• PostgreSQL 9.0 with PostGIS 1.5.2
MapInfo Professional 11.0 9 Install Guide
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Further, using ODBC drivers, you can access your data from MapInfo Professional using: 

• Microsoft SQL Server 2005
• Microsoft SQL Server 2008 Native Client
• Oracle ODBC Driver 11.2 
• Oracle Instant Client version 11.2.0.1.0
• PostgreSQL ANSI ODBC driver 8.x (which comes with PostgreSQL 9.0)

You can also open tables of data from the following databases and make them mappable, but only 
for point data:

• Microsoft Access 2007, 2010
• Microsoft SQL Server 2005
• Microsoft SQL Server 2008 XY on a spatialized database
• Oracle Spatial 11G, 10Gr2

For more about working with remote database information, see Accessing Remote Data and Setting 
your Database Connection Preferences in the Help System.

A Note about SQL Server 2005 Support 
MapInfo Professional supports the changes in the MS SQL Server 2005 schema concept. Microsoft 
has enhanced SQL Server 2005 to use schemas to organize database objects into namespaces. In 
the past the schema was part of the owner/user construct, so when you deleted a user, you deleted 
the objects associated with that user. 

Using SQL Server 2005, objects are associated with a schema, which can be associated with many 
users and each user can be associated with many schemas. 

The old fully qualified name of a database object was:

Server.Database.User.Object.

The new fully qualified name of the object is:

Server.Database.Schema.Object 

If you leave out the server and database name identifiers, MapInfo Professional uses the current 
server and database names. If you do not explicitly specify a schema for a user, the server assumes 
any unqualified object names are in the default schema. Therefore, if you are accessing a SQL 
Server 2005 database, you need to update any features/functions, tools, and test scripts accessing 
the objects, including the metadata in the MAPCATALOG, to use the new fully or partially qualified 
object name. 

To make this version of SQL Server work, you must have this 8.5.1 (or later) version of MapInfo 
Professional. There is a work around for MapInfo Professional 8.5 and earlier versions that 
accesses a server table with the form, Database.Owner.Object. Review the MapInfo Professional 
8.5 User Guide for these instructions.
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MapInfo Professional Data File Support
You can open the following file types using the File > Open capability in MapInfo Professional:

• ACCDB – Microsoft Access 2007 or later files
• CSV – Comma Delimited files
• DBF – dBASE DBF files
• MDB – Microsoft Access files 
• TAB – MapInfo .TAB files 
• Raster image files – (*.bil, *.sid, *.gen, *.adf, *.img, *.ntf, *.ecw, *.url, *.tif, *.grc, *.bmp, *.gif, 

*.tga, *.jpg, *.pcx, *. jp2, *.j2k, *.png, *.psd, *.wmf, *.emf, *.map)
• SHP – ESRI Shapefiles 
• TXT – Delimited ASCII files 
• WKS – Lotus 1-2-3 files (*.wk1, *.wks, *.wk3, *.wk4)
• WOR – MapInfo workspace files
• MWS – MapInfo workspace files
• XLS – Microsoft Excel files 
• XLSX – Microsoft Excel 2007 or later files
• Grid images – (*.adf, *.flt, *.txt, *.asc, *.img, *.dem, *.dt0, *.dt1, *.dt2, *.mig, *.grd)This release 

does not support .XLSM and .XLSB Excel files.

Grid Format Direct Support: The following grid handlers support direct read of DEM-USGS 
Text (.dem); GTOPO30 (.dem) and DTED levels 1, 2, 3 (.dt0, .dt1, .dt2). These grid handlers 
are read-only; they cannot be used to create grid files during the Create Grid Thematic 
interpolation process.

Using the Universal Translator, you can import these file format types:

• *CATD.DDF – Spatial Data Transfer Standard (SDTS), such as TR01CATD.DDF
• DWG, DXF – AutoCAD

MapInfo Professional only supports Table > Import (DXF) to release 13. This table import 
functionality is superseded by the Universal Translator and Open Universal Data feature.

• DGN – Microstation Design files (DGN)
• E00 – ESRI ArcInfo format
• *.*FT – Vector Product Format (VPF), such as POAREA.AFT, POLINE.LFT, POPOINT.PFT
• MID, MIF – MapInfo file formats (MIF)
• SHP – ESRI Shapefile format 
• TAB – MapInfo .TAB files

You can import the following file types into MapInfo Professional using Table > Import:

• DXF – The graphic/data interchange format (DXF) for AutoCAD and other CAD packages
• GML – OS MasterMap format
• GML, XML – Geographic Markup Language (GML) 2.1
• IMG – A file format for MapInfo Professional for DOS image files
• MBI – MapInfo Professional Boundary Interchange format (MBI)

An ASCII file for MapInfo DOS boundary files.
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• MIF – MapInfo Professional Interchange Format (MIF)
MapInfo Professional’s data interchange format (ASCII file format).

• MMI – MapInfo DOS MMI

You can download raster handlers for NIMA formats such as ADRG, CADRG, ASRP, CIB, 
USRP, and NITF formats from the Pitney Bowes Software Inc. website or get them from the 
Installation DVD.

MapInfo Professional imports graphics and textual information from MapInfo Professional 
Interchange Format, DXF, MBI, and MMI files. MapInfo Professional imports only graphics from 
IMG.

These are the Raster image file formats MapInfo Professional supports:

• ADF – ArcInfo coverage Data File (ADF)
• ASC – ASCII text file
• BIL – Satellite Pour l'Observation de la Terre (SPOT) satellite images

Spot Image Formats 1.5 and 4.0: 8 Bit Gray, Format 1.5, 8 Bit Gray, Format 4.0, 24 Bit Color, 
Format 1.5, 24 Bit Color, Format 4.0

• BMP – Windows bitmap (BMP) Monochrome: 8 Bit Color, 24 Bit Color
• filename.* – Compressed ARC Digitized Raster Graphic (CADRG) format
• filename.* – Controlled Image Base (CIB) format
• ECW – Enhanced Compression Wavlet (ECW) 2.0 format handler by ER Mapper
• EMF – Enhanced Metafile Format
• FLT – Image Filter (FLT)
• GEN – ARC Digitized Raster Graphic (ADRG) format
• GEN – ARC Standard Raster Product to 1.2 (ASRP) 1.2 format
• GIF – Graphics Interchange Format (GIF)
• GIF – Graphics Interchange Format (GIF89a) non-interlaced only Monochrome: 8 Bit Color
• GRC – MapInfo Vertical Mapper
• GRD – MapInfo Vertical Mapper

MapInfo Professional treats GRD files as either a grid or raster image. If the associated .TAB file 
contains a RasterStyle 6 entry, then MapInfo Professional treats the file as a grid.

• JFIF – JPEG File Interchange Format (JFIF) 
8 Bit Gray, 24 Bit Color, No Subsampling, 24 Bit Color, YUV422 Subsampling, 24 Bit Color, 
YUV411 Subsampling

• JP2 – Joint Photographic Experts Group (JPEG) 2000 format
MapInfo Professional supports creating JPEG 2000 files using Save Window As and viewing 
JPEG 2000 files using the LeadTools raster handler.

• JPG – Joint Photographic Experts Group (JPG)
• JPEG – Joint Photographic Experts Group (JPEG)

8 Bit Gray, 24 Bit Color, No Subsampling, 24 Bit Color, YUV422 Subsampling, 24 Bit Color, 
YUV411 Subsampling

• NTF – National Imagery Transmission Format (NITF) version 2.x format
• PCX – ZSoft Paintbrush 
• PCX – Format Version 5 (Paintbrush Version 3.0)

Monochrome, 8 Bit Gray, 8 Bit Color, 24 Bit Color
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• PNG – Portable Network Graphics (PNG) format
• PSD – Photoshop 3.0
• SID – MrSID format

The MrSID raster handler allows you to open and display raster images compressed in the 
MrSID format 

• TIF – Geographic Tagged Image File Format (GeoTIFF)
• TIF – Tagged Image File Format (TIFF)

TIFF Revision 5.0, Monochrome (Class B), Uncompressed, Monochrome (Class B), PackBits 
Compression, 8 Bit Gray (Class G), Uncompressed, 8 Bit Color (Class P), Uncompressed, 24 Bit 
Color (Class R), Uncompressed

• TIF – Tagged Image File Format (TIFF) CMYK
• TIF – Tagged Information File Format (TIFF) CCITT Group 4
• TIF – Tagged Information File Format (TIFF) LZW
• TXT – Text
• TGA – Targa 

TGA Truevision File Format Specification 2.0. 8 Bit Gray, 8 Bit Color, 24 Bit Color
• WMF – Windows Metafile Format (WMF)

The raster handler will load a rasterized version of the WMF file.

File Limitations for MapInfo Professional Supported Formats

Keep the following notes in mind when working with these MapInfo formats:

• MapInfo Professional only supports the DXF file import to release 13. This has been 
superseded by the Universal Translator and Open Universal Data feature.

• The Open Universal Data feature supports all DXF formats up to the current AutoCAD 
release. While it is our company’s intention to keep pace with the new releases of FME, if you 
extend the application to import AutoCAD DXF files using a newer version of FME before we 
have upgraded our product, errors may occur

• You can have maximum 500 files open at a time in MapInfo Professional if you remove the 
HKEY_LOCAL_MACHINE\SOFTWARE\MapInfo\MapInfo\Common Max Files registry key

• You can have up to 125 files open at a time for editing in MapInfo Professional.

Feature Manipulation Engine (FME) Format Support
MapInfo Professional 11.0 installs with the Feature Manipulation Engine (FME) 2011, which lets you 
open data directly to avoid having to translate it separately and work with copies of the data in .tab 
format. This FME opens a variety of Universal Data formats including:

• Autodesk AutoCAD DWG/DXF – Supports AutoCAD file versions up to and including 2010
• Bentley MicroStation Design (V7) – Supports Intergraph Standard File Format (ISFF) Version 7
• Bentley MicroStation Design (V8) – Supports Intergraph Standard File Format (ISFF) Version 8
• ESRI Geodatabase (MDB) – Supports ArcGIS 10
• Google Earth KML – Supports KML 2.2
• MapInfo TAB (MFAL) – Support MapInfo File Access (MFAL) version 2.4.0.2

For more information about FME format support, see http://www.safe.com/data-formats.
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MapInfo Professional Web Server Support
MapInfo Professional supports the Web Feature Server (WFS) 1.0 and GML 2.0, and supports the 
Web Map Server (WMS) 1.3. MapInfo Professional also supports the mapping tile servers:

• Microsoft Bing tile server
• MapInfo Developer tile server
• MapXtreme.NET tile server
• OpenStreetMap tile server

Before You Install MapInfo Professional
Before installing MapInfo Professional, record your serial number and access code in an easy-to-
remember place. You need a valid serial number and access code to complete an installation or an 
upgrade. Also, complete the postage-paid registration card and return it to Pitney Bowes Software 
Inc., or register online by accessing the Contact Info option on the DVD Browser.

It is possible that the MapInfo PDF Printer driver may not install when:

• Your IT department has a policy to disallow printer installations.
Contact your IT department to check if there is such a policy in place. If there is, then have them 
temporarily allow printer installation on your machine while you install MapInfo Professional.

• Your anti-malware or anti-spyware is turned on during the installation.
Contact your IT department to temporarily stop the anti-malware or anti-spyware on your 
machine while you install MapInfo Professional. 

If there are concerns about stopping anti-malware or anti-spyware, then try installing 
MapInfo Professional first and if the MapInfo PDF Printer driver does not install, uninstall 
MapInfo Professional, stop your anti-malware or anti-spyware, and then reinstall.

Upgrading
If the MapInfo Professional installer detects a current version of the product, or detects that the 
product had been previously installed, then the installer copies the MAPINFOW.WOR, 
STARTUP.WOR and MAPINFOW.PRF from the operating system's system directory to <user 
profile root>\Application Data\MapInfo\MapInfo.

Application data (appdata) files are the non-executable data files that MapInfo Professional uses 
during operation.

64-bit Editions of Office 2010
Microsoft recommends installing a 32-bit version of Microsoft Office when you are dependent on 
using 32-bit applications that interact with Office. In this case, MapInfo Professional is 32-bit 
application that requires 32-bit drivers to work with Microsoft Office data, such as Access and Excel.
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Microsoft offers detailed information at http://technet.microsoft.com/en-
us/library/ee681792.aspx. This web posting includes the following recommendations for which 
edition of Office 2010 to install:

• If users in your organization depend on existing extensions to Office, such as ActiveX controls, 
third-party add-ins, in-house solutions built on previous versions of Office, or 32-bit versions of 
programs that interface directly with Office, we recommend that you install 32-bit Office 2010 
(the default installation) on computers that are running both 32-bit and 64-bit supported Windows 
operating systems. 

If some users in your organization are Excel expert users who work with Excel spreadsheets that are 
larger than 2 gigabytes (GB), they can install the 64-bit edition of Office 2010. In addition, if you have 
in-house solution developers, we recommend that those developers have access to the 64-bit 
edition of Office 2010 so that they can test and update your in-house solutions on the 64-bit edition 
of Office 2010.

Navigating the MapInfo Professional DVD Browser
The initial screen of the MapInfo Professional DVD Browser includes these options:

• Install Products
From this option you can install MapInfo Professional (including DBMS support and 
translators), free data, and Install Utilities, including: ECW Compressor and GPS.

• What’s New
Displays a list and description of new and enhanced features.

• Online Reference
MapInfo Professional provides links to online reference documents, such as the MapInfo 
Professional Install Guide (this document) and MapInfo Professional User Guide, as well as 
the Adobe Acrobat Reader. These documents are copied into the Documentation subfolder 
of your installation directory during the installation process.

• MapInfo Tutorial
From this option you can access the MapInfo Professional Tutorial from the Pitney Bowes 
Software Inc. web site to learn more about the basic features of the product.

• Other Products
Displays information about MapBasic, MapInfo Vertical Mapper, and other products from our 
website.

• Contact Information
Where ever you are, Pitney Bowes Software Inc. is there to help you. Contact us at any of 
these locations or visit us on the world wide web at www.pbinsight.com!

• Register Online
To register your product, simply click this entry and the wizard walks you through the 
registration process quickly.

• Browse DVD
From this option you can review the contents of the DVD. There are additional utilities that 
may be useful to you that are only available when you browse.

• Exit
From this option you can close the DVD Browser application.
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Citrix Installations
Typically, a Citrix installation is performed by an IT Specialist or a system administrator, but this is 
not always the case.

There are no special installation instructions for installing MapInfo Professional in a Citrix 
environment. In addition to the product serial number and access code (supplied on the Product 
Activation Information Card in the product box), you will also need the MapInfo License Server 
machine name and port number to activate MapInfo Professional with. Your system administrator 
will supply this information.

Information for IT Specialist or System Administrators
In addition to MapInfo Professional, you will also have purchased:

• A MapInfo License Server Utility to activate MapInfo Professional with. 
Citrix installations require a MapInfo License Server Utility to activate MapInfo Professional. For 
instructions on how to install and set up a MapInfo License Server for your organization, see the 
User Guide that is provided with the Pitney Bowes Software Inc. License Server.

• One or more concurrent non-borrowing serial licenses for MapInfo Professional, depending on 
the number of MapInfo License Servers you require and the number of users serviced. 
For instructions on how to activate a MapInfo Professional installation, see Distributable 
Licenses on page 41 in Chapter 3: Starting and Activating MapInfo Professional.

Number of MapInfo Professional Instances a Citrix Server can Support
The Citrix server should comply with the basic requirement provided by Citrix. 

To determine the amount of RAM required for your Citrix server to serve MapInfo Professional, 
multiply the base footprint by the number of concurrent MapInfo Professional users. If the footprint is 
100M and there are five (5) concurrent MapInfo Professional users, then multiply 5 x 100M = 500M 
RAM required.

The previous calculation is an estimate, because MapInfo Professional has many dependencies, 
such as the type of data in use and type and frequency of operations performed. Different operations 
may have different memory requirements; the following are the most memory intensive operations:

• Running object processing operations, with Clean and Check Regions being most intensive
• Running complex SQL statements
• Editing and drawing objects
• Extensive use of the cosmetic layer
• Extensive labeling
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Installing MapInfo 
Professional
This chapter provides instructions for installing MapInfo Professional on your 
desktop. In addition, there are instructions for fixing problems that come up as 
part of the installation process and for removing MapInfo Professional from your 
desktop.

Topics in this Section:
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Installing MapInfo Professional
CAUTION: We strongly recommend that you exit from all Windows programs before 

beginning the installation process. If you are upgrading from an earlier version 
of MapInfo Professional, we recommend that you uninstall before upgrading.

You must have Administrator rights to run the Installer.

If the Windows Start menu does not have a MapInfo program folder, the installation process creates 
this folder. If your Windows Start menu already has a MapInfo program folder, this process creates a 
new MapInfo icon within that folder.

MapInfo Professional provides its application data files to each user. Called a Per-User install, this 
functionality runs the first time you run MapInfo Professional or MapInfo Professional client on a 
machine, and each time the MapInfo Professional Installer is run thereafter. The application data 
files include, among others, the Pen Styles file, Custom Symbols files, Graph Support files, and 
Thematic Legend templates. These files allow different users to have custom settings.

The Installer requires that your TEMP variable be set to a valid directory.

To install MapInfo Professional:

1. On the Launcher menu, choose Install Products from the MapInfo Professional DVD Browser.

2. Choose MapInfo Professional.

3. Choose MapInfo Professional Installer.
Windows 7 users: You may see a prompt for permission to continue. Click Allow or Yes to 
proceed (if you do not respond and the message times-out, the install is unsuccessful).

4. If any of the prerequisites listed under Dependencies and Prerequisites on page 9 are not 
already installed on your system, then a prompt displays to install them. Click Install. Installing 
the prerequisites takes several minutes—the status of each prerequisite updates as it installs.
If you see a message that MapInfo Professional requires a reboot, click Yes. You must reboot to 
continue with the installation.
Click Next to continue the process.

5. In the License Information screen, review the license. If accepting the terms, click Next to 
continue. 

6. In the Customer Information screen, type your name, organization name, serial number, and 
access code in the corresponding fields. 

Do not select the check box. Doing so installs an evaluation copy of MapInfo 
Professional. If you select to install an evaluation copy, then you may activate your copy 
after installation with your serial number and activation code.

The serial number and access code are listed on the Product Activation Information Card in the 
product box and are used to activate your product. 
Click Next to continue.
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7. Do one of the following: 
• If your organization purchased node-locked licenses, the third character of your serial 

number is "N". Skip this step and go to step 8. 
• If your organization purchased concurrent licenses, the third character of your serial number 

is "S". In those cases, the License Server Name and Port screen displays on the screen.

For more information about node-locked and concurrent licenses, see Chapter 3: 
Starting and Activating MapInfo Professional. 

If you know the license server name and port number, enter them here. If you do not, you can 
continue with the installation without filling in the license server name and port number. You 
will have another opportunity to supply this information when you start MapInfo Professional. 
Click Next.
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8. Review the following installation types and determine which instructions are appropriate. Select 
one of the following options and then click Next to continue:
• Typical Workstation Installation. Click this option if you will be using MapInfo Professional 

as a desktop application including remote database access and connectivity. Continue to 
Typical Workstation Installation on page 20.

• Custom Workstation Installation. Click this option to restrict the components that are 
installed by the installation program. For example, you can prevent the installer from adding 
the help system and tools. Continue to Custom Workstation Installation on page 21.

There are no special installation instructions for installing MapInfo Professional in a Citrix 
environment. Citrix users follow the Typical Workstation Installation instructions to install 
MapInfo Professional.

Typical Workstation Installation

CAUTION: Make sure you have completed the directions in Installing MapInfo Professional 
on page 18 before beginning these instructions.

Choose this option to install all MapInfo Professional program files including the Online Help, Tools, 
Universal Translator, and Crystal Reports.

To continue installing MapInfo Professional on a workstation:

1. In the Setup Type screen, click Typical Workstation Installation; the Destination Folder screen 
displays. If you have an earlier version (or versions) of MapInfo Professional installed and you do 
not want to overwrite that version, create a new directory name in the next step.

2. Do one of the following:
• Click Next to accept the destination folder indicated
• Click Change to create a new path in the Change Current Destination Folder screen. Type 

the new path in the Folder name field and click OK to continue. Click Next to continue.
The Ready to Install the Program screen displays. Review your selections to ensure that the 
path is correct before moving on. Click Back to make changes.

3. Click Install to begin. A progress bar indicates the status of the process.

If you are using ODBC or Oracle Spatial for database connectivity, we install ODBC 
Connectivity and Oracle Spatial support by default to simplify the connectivity process.

4. At the end of the installation, the prompt: “Would you like to check our web site for any current 
updates to our product?” displays. If you have an Internet connection, click Yes to access the 
Pitney Bowes Software Inc. web site containing information about product updates.

5. When the Complete screen displays, choose Finish to return to the Install Products screen.

Continue to Installing Data on page 22 or to Chapter 3: Starting and Activating MapInfo 
Professional.
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Custom Workstation Installation

CAUTION: Make sure you have completed the directions in Installing MapInfo Professional 
on page 18 before beginning these instructions.

Choose this installation type to select components and drivers within the MapInfo Professional 
installation program. This is useful when you want to save disk space by not installing the Help 
System, the documentation, or the MapInfo Professional tools.

To continue installing using the custom workstation instructions:

1. In the Setup Type screen, click Custom Workstation Installation.

2. In the Custom Setup screen, you can click on a component to display information about it and 
the space it requires:
• MapInfo Program Files – you must install these files to run MapInfo Professional
• Documentation – installs user guide documents in PDF format
• Tools – installs MapInfo Utilities and Crystal Reports
Select the components that you do not want to install (all are selected by default) by clicking the 
Down Arrow beside it. From the following menu of options, select This feature will not be 
available.
• This feature will be installed on local hard drive.
• This feature, and all subfeatures, will be installed on local hard drive
• This feature will not be available

Some components have additional options to the use them from the network.

3. To specify a non-default location for the installation, click Change. The installation path displays 
below the Custom Setup list pane. 

4. To see if you have enough space on your hard drive or other mapped resources, click the Space 
button. The Disk Space Requirement screen displays the disk size, the amount of available 
space, and the amount of space the selected install would take. 

5. After making your custom selections click Next.

6. In the Language Setting screen, select an English language preference and then click Next.

7. In the Ready to Install the Program screen, click the Install button to begin the installation of 
MapInfo Professional with the features you selected. The Installing MapInfo Professional screen 
displays with a progress bar indicating the status. 

8. At the end of the installation, the prompt: “Would you like to check our web site for any current 
updates to our product?” displays. If you have an Internet connection, click Yes to access the 
Pitney Bowes Software Inc. web site containing information about product updates.

9. In the Complete screen, choose Finish to return to the Install Products screen.

Continue to Installing Data on page 22 or to Chapter 3: Starting and Activating MapInfo 
Professional.
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To help you get started, Pitney Bowes Software Inc. provides you with some United States-based 
and world-wide maps you can use as a background to your data. Use these instructions to install this 
free data.

To install the free data provided with MapInfo Professional:

1. From the MapInfo Professional DVD, choose Install Products from the DVD Browser.

2. Choose Introductory Data and Industry Samples.

3. Choose Install Introductory Data and Industry Samples.
Windows 7 users: You may see a prompt for permission to continue. Click Allow or Yes to 
proceed (if you do not respond and the message times-out, the install is unsuccessful).

4. In the Welcome screen, click Next to continue.

5. In the License Agreement screen, review the license. After accepting the terms, click Next to 
continue. 

6. In the Setup Type screen, choose one of these options: 
• Complete to Install all datasets, and then click Next. Continue to Complete Data 

Installation.
• Custom to choose which datasets to install, and then click Next. Continue to Custom Data 

Installation.

There are no special installation instructions for installing MapInfo Professional data in a 
Citrix environment. Citrix users follow the Complete Data Installation instructions to install 
MapInfo Professional data.

Complete Data Installation

CAUTION: Make sure you have completed the directions in Installing Data on page 22 
before beginning these instructions.

Choose this option to install all of the MapInfo Professional sample data.

To continue installing data using the Complete data instructions:

1. In the Destination Folder screen, either keep the default location or click Change to select a 
different location to install the data to. The default installation path is C:\Program 
Files\MapInfo\Data.
Click Next.

2. In the Related Products screen, select the product that will be using this data: MapInfo 
Professional or MapInfo Runtime, and then click Next.
If you will be using the data with both MapInfo Professional and MapInfo Runtime, then select 
MapInfo Professional.

3. If you selected MapInfo Professional in the previous step, a Question dialog box displays. 
Select Yes to create workspace icons for the data.
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4. In the Ready to Install the Program screen, click Install.

Custom Data Installation

CAUTION: Make sure you have completed the directions in Installing Data on page 22 
before beginning these instructions.

Choose this option to install some of the MapInfo Professional sample data. The data only installs to 
one folder location.

To continue installing data using the Custom data instructions:

1. In the Custom Setup screen, clicking on a dataset displays information about it and the space it 
requires. Select the datasets that you do not want to install (all are selected by default) by 
clicking the Down Arrow beside it. From the following menu of options, select This feature will 
not be available.
• This feature will be installed on local hard drive.
• This feature, and all subfeatures, will be installed on local hard drive
• This feature will not be available

2. To specify a non-default location for the installation, click Change. The default installation path is 
C:\Program Files\MapInfo\Data.

3. To see if you have enough space on your hard drive or other mapped resources, click the Space 
button. The Disk Space Requirement screen displays the disk size, the amount of available 
space, and the amount of space the selected install would take. 

4. After making your custom selections click Next.

5. Depending on what data you selected to install in step 1, the Related Products screen displays. 
Select the product that will be using this data: MapInfo Professional or MapInfo Runtime, and 
then click Next.
If you will be using the data with both MapInfo Professional and MapInfo Runtime, then select 
MapInfo Professional.

6. If you selected MapInfo Professional in the previous step, a Question dialog box displays. 
Select Yes to create workspace icons for the data.

7. In the Ready to Install the Program screen, click Install.

Continue to Installing Related Programs and Resources on page 24 or to Chapter 3: Starting 
and Activating MapInfo Professional.

Getting More Data
To learn more about our products, choose Install Products, Introductory Data and Industry 
Samples, and Obtain More Data from the MapInfo Professional DVD browser, or after installing 
MapInfo Professional, click MapInfo Data Products on the Web in the Help Menu. If you have a 
Browser installed, you are automatically connected to Pitney Bowes Business Insight web site, 
where we provide detailed information about our World Wide Data Products. We have over 350 data 
products to choose from—products that provide both reliable and current information.
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Installing Related Programs and Resources
This section contains the instructions for installing the ECW Compressor, the Blue Marble GPS, and 
the documentation associated with MapInfo Professional.

The first time you start MapInfo Professional you must activate your product license. After installing 
related programs and resources, continue to Chapter 3: Starting and Activating MapInfo 
Professional. 

Installing the ECW Compressor
The ECW raster handler allows you to open and display raster images compressed in the ECW 
format. We recommend that you exit all Windows programs before installing.

1. Choose Install Products from the MapInfo Professional DVD Browser.

2. Choose Additional Utilities. 

3. Choose ECW Compressor. 
Windows 7 users: You may see a prompt for permission to continue. Click Allow or Yes to 
proceed (if you do not respond and the message times-out, the install is unsuccessful).

4. The Welcome screen displays. Click Next to continue the installation process.

5. The Software License screen displays. Click Yes to accept the terms of the agreement and to 
continue the installation process.

6. The Choose Destination Location screen displays. Specify the directory where ECW 
Compressor will be installed. 

7. The Select Program Folder screen displays. Select a folder. Click Next to continue. 

8. The Setup Complete screen displays: choose to display the ReadMe file and/or create a shortcut 
on your desktop. Click Finish. 

Installing Global Positioning Software (GPS)
To install Global Positioning Software from Blue Marble: 

1. Choose Install Products from the MapInfo Professional DVD Browser.

2. Choose Additional Utilities. 

3. Choose Install GPS Support. 
Windows 7 users: You may see a prompt for permission to continue. Click Allow or Yes to 
proceed (if you do not respond and the message times-out, the install is unsuccessful).

4. A prompt displays to exit all applications before installing. Click OK.

5. The MapInfo Special Edition screen displays. Click OK.

6. The Select Destination Location screen displays. Specify the directory where GPS will be 
installed.
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7. The Software License screen displays. Click YES to accept the terms of the agreement and to 
continue the installation process.

8. The Add to the Start Menu screen displays: click Yes to add a shortcut to the Start menu.

9. The ReadMe displays; click OK to exit the ReadMe. 

Installing the Online References

MapInfo Professional installs documentation, such as the following, to the Documentation subfolder 
of your installation directory:

• MapInfo Professional Licensing and Activation
• MapInfo Professional Install Guide
• MapInfo Professional User Guide

If you have any questions about the use of the Acrobat Reader, contact Adobe support at 
www.Adobe.com.

Troubleshooting your Installation
The Installer must be run from a drive with a letter such as G: and not from an explicit UNC path. For 
example, you might have the MapInfo Professional DVD in your computer as USERSPC. Other 
users may share this device as USERSPC; however, it would not contain a drive letter. The MapInfo 
Professional Installation program requires a drive letter. 

To remedy this situation, map your network drive to a specific drive letter: 

1. In Windows Explorer, right-click the shared directory or DVD drive that contains the MapInfo 
Professional SETUP.EXE and select Map Network Drive. 

2. Choose a drive letter to map.

3. Choose MapInfo Professional Installer.

4. Run the Installation Program again from the newly mapped drive letter. 
Windows 7 users: You may see a prompt for permission to continue. Click Allow or Yes to 
proceed (if you do not respond and the message times-out, the install is unsuccessful).

Modifying or Removing MapInfo Professional
Use the Program Maintenance feature of the DVD Browser to modify, repair, or remove MapInfo 
Professional.

To set MapInfo Professional preferences, see Setting MapInfo Professional Preferences in 
the Help System.
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To access Program Maintenance:

1. Choose Install Products from the MapInfo Professional DVD Browser.

2. Choose MapInfo Professional. 
Windows 7 users: You may see a prompt for permission to continue. Click Allow or Yes to 
proceed (if you do not respond and the message times-out, the install is unsuccessful).

3. The Welcome screen displays. Choose Next. The Program Maintenance screen displays.

4. Choose modify, repair, or remove MapInfo Professional based on your needs. 
• Click Modify to display the Custom Setup screen. 
• Click Repair to repair installation errors in the program.
• Click Remove to remove an existing copy of MapInfo Professional from your system. The 

installer displays the Remove the Program dialog box. Click Remove to uninstall the 
product’s programs from your system.

You can also access the Program Maintenance screen from the Start menu by clicking Control 
Panel and then Add/Remove Programs and finally MapInfo Professional.
For information on node-locked license transfer options at uninstall, see Chapter 3: Starting 
and Activating MapInfo Professional.

Removing MapInfo Professional from your System using Control Panel 
Remove MapInfo Professional by accessing the DVD Browser, Program Maintenance screen, or by 
choosing the Add/Remove Programs option in the Control Panel in Windows.

Removing MapInfo Professional from your System using the DVD 
Browser 

To uninstall MapInfo Professional:

1. Choose Install Products from the DVD Browser.

2. Choose MapInfo Professional. 
Windows 7 users: You may see a prompt for permission to continue. Click Allow or Yes to 
proceed (if you do not respond and the message times-out, the install is unsuccessful).

3. The Welcome screen displays. Choose Next. 

4. The Program Maintenance Screen displays. Choose Remove.
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Starting and Activating 
MapInfo Professional
The first time you start MapInfo Professional you are asked to activate your 
product using the serial number and access code you supplied during the 
installation. This section describes the activation process for the type of license 
your organization purchased.

To start MapInfo Professional, do one of the following:

• Double-click the MapInfo Professional icon on your desktop.
• From the Start menu, select MapInfo Professional 11.0 from the 

Selected Program folder.
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Determine the Type of License you have
The serial number and access code that you enter during the installation indicates to MapInfo 
Professional what type of license you have. Depending on the license type, MapInfo Professional 
will guide you through activating the product (if your organization purchased node-locked licenses) 
or connecting to a license server (if your organization purchased concurrent or distributable 
licenses). 

To determine what type of license you have:

• If the third character of your serial number is "N", your organization purchased node-locked 
licenses. For activation instructions, see Node-Locked Licenses on page 28.

• If the third character of your serial number is "S", your organization purchased concurrent 
licenses. For activation instructions, see Concurrent Licenses on page 38.

• If you have limited access to email, or have installed MapInfo Professional in a Citrix 
environment, then your organization purchased concurrent non-borrowing serial licenses. Your 
system administrator will provide you with a license server machine name and port number. For 
activation instructions, see Distributable Licenses on page 41.

Node-Locked Licenses
Node-locked licenses enable you to run MapInfo Professional on a specific computer. If you 
purchased node-locked licenses, your installation of MapInfo Professional must be activated before 
you can use it. Activation is the process of acquiring a license from Pitney Bowes Business Insight. 
This section explains the activation options available for node-locked licenses. 

Product Activation
Pitney Bowes Business Insight uses the serial number and access code you supplied during the 
installation to activate the product. If you need to refer to these numbers again, the serial number 
and access code are located on the product box and on the Product Activation Information Card. 

To activate MapInfo Professional: 

1. Install MapInfo Professional, if you haven’t already, and start the product. When you start 
MapInfo Professional for the first time after installation, the Activation Wizard launches. The 
MapInfo Professional Activation dialog box displays. 
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2. Select when you want to activate MapInfo Professional. Select one of the following:
• Activate Now–Select this option to start activation now. 
• Activate Later–Select this options to start a 30-day courtesy period in which you can use 

MapInfo Professional without activating the product. 

3. Click Next. 
If you selected Activate Now, go to step 4.
If you selected Activate Later, the Activation Wizard closes and the courtesy period begins. The 
courtesy period enables you to use MapInfo Professional immediately and active the product at 
a time that is convenient for you. Each subsequent time you start MapInfo Professional, a dialog 
box displays informing you of the time remaining in the courtesy period and giving you the 
opportunity to activate the product. 
You must activate MapInfo Professional sometime during the courtesy period to avoid 
interrupting your work. When the courtesy period ends, you will not be able to use MapInfo 
Professional until you activate it. 

4. If you selected Activate Now, the Select Activation Method dialog box displays on the screen: 
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:

5. Select one of the following activation methods: 
• Automatic Activation– Select this option if you have an Internet connection. The Activation 

Wizard will make a one-time connection with a Pitney Bowes Business Insight server. Using 
the serial number and access code you provided during the installation, the Activation Wizard 
will retrieve one of the licenses your organization purchased and associate it with your 
computer. 

• Email Activation– Select this option if you do not have an Internet connection. The 
Activation Wizard will guide you through the creation of an Activation Request file that you 
must then email to Pitney Bowes Business Insight. 

6. Click Next. 
If you selected Email Activation, go to step 7.
If you selected Automatic Activation, the Activation Wizard takes a few moments to transfer 
the activation credentials to Pitney Bowes Business Insight and perform the activation. An 
activation message displays on the screen to tell you that the activation was successful. 
Click OK. The Activation Wizard closes, and MapInfo Professional is ready to use. You are 
finished.

7. If you selected Email Activation, the Verify Activation Credentials dialog box displays on the 
screen:
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Double-check that your serial number and access code are correct. Click Edit if you need to 
make any corrections. 

8. Click Next. The Specify location to save Activation Request file dialog box displays on the 
screen: 

Select a folder in which to save the Activation Request file. Click the Browse button to navigate 
to the desired location. Click OK. The path and filename of the Activation Request file appear in 
the box. The Activation Request contains your serial number and access code, plus information 
that identifies the computer you are activating on. 

9. Click Next. The Save this important Information dialog box displays on the screen. 
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This dialog box provides the information to send your Activation Request file to Pitney Bowes 
Business Insight. The full path and filename of the Activation Request file is displayed in the 
Activation Request File box. The email address to send the file, activation@pb.com, is 
displayed in the Email address box. 
Take a few moments to write down the location of the Activation Request file and email address 
to send the Activation Request file. 

CAUTION: Please do not edit the Activation Request file in any way. If you do, Pitney 
Bowes Business Insight may not be able to process it and your activation will be 
delayed. 

10. Click OK. The Activation Wizard closes and the courtesy period automatically starts. 

11. Email your Activation Request to Pitney Bowes Business Insight at this address:
activation@pb.com

You can finish email activation when you receive an Activation Response file from Pitney Bowes 
Business Insight. You should receive the Activation Response file within one business day. 

Finishing Email Activation
When you receive the Activation Response file from Pitney Bowes Business Insight, you are ready 
to finish activating MapInfo Professional. 

To finish email activation:

1. Copy the Activation Response file you received from Pitney Bowes Business Insight to an 
accessible folder on your computer and make note of the location. 

2. Open MapInfo Professional. If MapInfo Professional is already open, exit and restart the 
program. A dialog box displays asking you if you want to finish activating MapInfo Professional. 

3. Click Yes. The Process Email Activation Response dialog box displays on the screen. 
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4. Click Browse to navigate to the location of the Activation Response file. Click Open in the 
Locate Response file dialog box when you have located the file. 

5. The path and filename of the Activation Response file appear in the box. 

6. Click Next. 

7. An activation message displays on the screen to tell you that the activation was successful. Click 
OK. The MapInfo Professional Activation Wizard closes, and MapInfo Professional is activated 
and ready to use. You are finished.

Once you have seen the confirmation message stating that your product has been activated, 
you can delete the email response file from your system. 

To check the status of your activation, choose Help > About and review the contents of this dialog 
box.

Using MapInfo Professional While You Wait
While you are waiting for Pitney Bowes Business Insight to send you the Activation Response file, 
you can continue to use MapInfo Professional under the courtesy period. To ensure uninterrupted 
use of MapInfo Professional, we encourage you to activate before the courtesy period expires. 

Each time you open MapInfo Professional subsequent to initiating email activation, a dialog box 
displays asking if you want to finish activating MapInfo Professional. When you receive the 
Activation Response file from Pitney Bowes Business Insight you are ready to finish activation.
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To continue using MapInfo Professional under the courtesy period: 

1. Click No in the dialog box. 

2. A dialog box displays on the screen that provides information about the courtesy period and asks 
you how you would like to proceed. 
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Select one of the following: 

• Use MapInfo Professional–Select this option if you have not received an Activation 
Response file yet and you want to use MapInfo Professional under the courtesy period.

• Start Activation Over–Select this option if previous activation attempts have failed. 
If you selected Use MapInfo Professional, click Finish. The Activation Wizard closes and 
MapInfo Professional is ready to use under the courtesy period. You can finish the activation at a 
later time. 
If an earlier attempt to activate MapInfo Professional failed, and you selected Start Activation 
Over, click Next. The Activation Wizard restarts, giving you the opportunity to try the activation 
again.

Transferring a Node-Locked License
Node-locked licenses are associated with a particular computer. To use MapInfo Professional on a 
computer other than the one on which you have it activated, and without consuming another license, 
you can transfer your license from one computer to another. For example, you received a new 
computer at work and you want to run MapInfo Professional on the new computer instead of on the 
old one. 

Your organization is limited to either 10 license transfers per year or two times the number of 
licenses you have purchased per year, whichever number is greater. For example, an 
organization with 50 node-locked licenses of MapInfo Professional is permitted 100 transfers 
per year. This lets you upgrade the entire set of user computers and provides for license 
transfers, such as when employees change roles.

Transferring Your License to another Computer

To transfer a node-locked license:

1. Open MapInfo Professional. 

2. Choose Help > Licensing > Transfer license. The MapInfo Professional License Transfer 
dialog box displays on the screen. 

3. Click Yes. The Select Transfer Method dialog box displays on the screen. 
Select one of the following transfer methods: 
• Automatic Transfer–Select this option if you have an Internet connection. Your license will 

be automatically transferred to Pitney Bowes Business Insight. You can retrieve the license 
by activating MapInfo Professional on another computer.

• Email Transfer–Select this option if you do not have an Internet connection. You will be 
guided through the creation of a Transfer Request file, which you must then email to Pitney 
Bowes Business Insight. 

4. If you selected Email Transfer, go to step 6.
If you selected Automatic Transfer, the License Transfer Wizard takes a few moments to 
transfer the license to Pitney Bowes Business Insight. When this process is finished, a message 
displays on the screen informing you that the transfer was successful. 
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5. Click OK. MapInfo Professional closes and can no longer be run from this computer. The license 
is now available for you to activate MapInfo Professional on another computer. 

6. If you selected Email Transfer, the Save Transfer Request File dialog box displays on the 
screen. 

Select a folder in which to save the Transfer Request file. Click the Browse button to navigate to 
the desired location. Click OK. 

7. Click Next. The Save this important information dialog box displays on the screen. 
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This dialog box provides the information to send your Transfer Request file to 
Customer Service.

The full path and filename of the Transfer Request file is displayed in the Transfer Request File 
box. The email address to send the file, activation@pb.com, is displayed in the Email address 
box. 
Take a few moments to write down the location of the Transfer Request file and email address to 
send the Transfer Request file. 

CAUTION: Please do not edit the Activation Request file in any way. If you do, Pitney 
Bowes Business Insight may not be able to process it and your activation will be 
delayed. 

8. Click OK. MapInfo Professional closes and can no longer be run on this computer unless you 
activate it again. 

9. Email the Transfer Request file to Pitney Bowes Business Insight at the following address: 
activation@pb.com

10. Customer Service will send you an email reply confirming that the transfer was successful. You 
should receive this confirmation within one business day. 

The license is now available for you to activate MapInfo Professional on another computer. 

Uninstall Transfer Options

If you have a node-locked license and you uninstall MapInfo Professional, you have the option of 
transferring the license to Pitney Bowes Business Insight. 

If you intend to install MapInfo Professional on another computer, transfer the license to Pitney 
Bowes Business Insight so that the license is available. When you install MapInfo Professional on 
the desired computer, you will be prompted to activate the product. 
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If you intend to reinstall MapInfo Professional on the same computer, do not transfer the license. 
When you reinstall, you can reuse the same license without activating.

When you begin uninstalling MapInfo Professional, the Transfer License Now? dialog box displays 
on the screen:

Do one of the following: 

• Click Yes to transfer the license to Pitney Bowes Business Insight. The License Transfer Wizard 
will start and guide you through the transfer process. See Transferring Your License to 
another Computer on page 35

• Click No to keep the license on this computer. The uninstall operation continues. When you 
reinstall MapInfo Professional, you can reuse the license without activating. 

Concurrent Licenses
Concurrent licenses enable you to install MapInfo Professional on any number of computers. A 
license server, installed and maintained by your organization, limits the number of computers that 
can run MapInfo Professional at any given time to the number of concurrent licenses purchased by 
your organization. 

In the concurrent licensing scheme, you must connect to a license server on your network to check 
out a license before you can run MapInfo Professional. Checking out a license is the process of 
obtaining a license from the license server. You will need to supply the license server machine name 
and port number to connect to the license server. You can do this either during installation or the first 
time you run MapInfo Professional. After you have established a license server connection, the 
check out occurs automatically. 

A license server administrator from your organization installs and maintains the license server. The 
license server administrator must also perform the following tasks: 

• Activate the license server to make licenses available for check out.
• Inform users of the license server machine name and port number.

Connecting to a License Server
If your organization purchased concurrent licenses for MapInfo Professional, you will need to 
connect to a license server to run the product. 

To connect to the license server, MapInfo Professional must have the license server name and port 
number. Your license server administrator will provide you with this information.

Connecting During Installation

The installation program will ask you for the license server name and port number. If you know them 
at install time, enter them. When you start MapInfo Professional, you will be connected to the license 
server and a license will be checked out automatically. 
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If you do not have this information at the time you install MapInfo Professional, the installation 
program will enable you to continue with the installation without filling in the license server name and 
port number. You will have another opportunity to connect to the server when you start MapInfo 
Professional. 

Connecting after Installation

If you did not specify the license server name and port number during product installation, you will be 
prompted for that information when you start MapInfo Professional. You will also be prompted if 
MapInfo Professional cannot connect to a running license server using the server name and port 
number you provided at install. 

To connect to the license server after you install MapInfo Professional:

1. Start MapInfo Professional. The Connect to License Server dialog box displays on the screen.

If you have the license server name and port number, proceed with these instructions. If you do 
not, see Starting the Courtesy Period on page 40.

2. Enter the license server name in the Server name box. 

3. Enter the port number in the Port number box. 

4. Click Connect. MapInfo Professional takes a few moments to connect to the license server and 
check out a license. 

When the license is checked out, the Connect to License Server dialog box closes. You are finished. 
MapInfo Professional is licensed and ready to use. After you successfully connect to your license 
server once, a license will be checked out automatically when you start MapInfo Professional. 
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Starting the Courtesy Period

If you do not have the license server name and port number, but you want to start using MapInfo 
Professional, you can start a 30-day courtesy period during which you can use MapInfo Professional 
without connecting to the license server. 

To use the courtesy period to run MapInfo Professional: 

1. Open MapInfo Professional. The Connect to License Server dialog box displays on the screen.

2. Click Courtesy Period. An activation message displays telling you that the courtesy period 
started successfully. 

3. Click OK. MapInfo Professional is ready to use under the courtesy period. 

You can connect to the license server and check out a license when you receive the license server 
name and port number from your license server administrator. 

Connection Failures

Failure to connect to the license server can occur for several reasons. 

First, although you may know the license server name and port number, the license server 
administrator may not have had an opportunity to install it yet. In this case, MapInfo Professional 
cannot find the license server you specified. To use MapInfo Professional, you can start the courtesy 
period, and then connect when you know that the license server has been installed and is running.

Failures can also occur if the license server has been moved to a different computer. In this case, 
you were previously able to connect to the license server, but the license server was moved since 
the last time you used MapInfo Professional. MapInfo Professional is looking for the license server in 
its previous location. If MapInfo Professional cannot connect to the license server at startup, the 
Connect to License Server dialog will display on the screen. See Connecting after Installation on 
page 39 for information. See your license server administrator for the correct license server name. 

Finally, if all licenses have been checked out, you will not be able to run MapInfo Professional. You 
are able to connect to the license server, but you cannot check out a license because they are all in 
use. You will need to wait until a license becomes available before you can check out a license. 

Borrowing a Concurrent License
Some concurrent licenses can be borrowed. Borrowed license enable you to use MapInfo 
Professional when your computer is not able to connect to your license server. For example, if you 
have MapInfo Professional installed on a laptop computer and you are going to be away from the 
office, you can borrow a license to use MapInfo Professional while you are away. Check with your 
license server administrator to find out if your concurrent license includes borrowing. 

When you borrow a license, be sure to specify a borrow period that gives you sufficient time to use 
MapInfo Professional before the license expires. If the license expires before you have an 
opportunity to return it, the license is automatically returned to the license server. MapInfo 
Professional is unusable until you can connect to your network again and check out a license.

To borrow a license, the computer that you want to put the borrowed license on must have MapInfo 
Professional installed and be connected to the license server. 
MapInfo Professional 11.0 40 Install Guide



Chapter 3: Starting and Activating MapInfo Professional
Distributable Licenses
To borrow a license: 

1. Open MapInfo Professional. 

2. Choose Help > Licensing > Borrow license. The Borrow MapInfo Professional License dialog 
box displays on the screen. 

3. Specify the number of days that you want to borrow the license. You can specify from one to 365 
days. 

4. Click Borrow License. After a few moments, an activation message displays on the screen to 
tell you that the license was borrowed from the server successfully. 

5. Click OK. 

You can use MapInfo Professional on this computer while not connected to your network for the 
borrow period that you specified. 

Returning a Borrowed License
To return a borrowed license, you must reconnect the computer that is using the borrowed license to 
your network. If it is not connected, the Return borrowed license command will not be available.

To return a borrowed license: 

1. Reconnect the computer to your network. 

2. Open MapInfo Professional. A dialog box displays to tell you on what date the borrowed license 
is going to expire. 

3. Click OK. 

4. Choose Help > Licensing > Return borrowed license. The Return borrowed license to license 
server dialog box displays on the screen.

5. This dialog box explains how a license is returned. Click OK. 

6. An activation message displays on the screen to tell you that the license has returned to the 
license server. 

7. Click OK. 

Distributable Licenses
We have developed a licensing model that allows companies to "distribute" permanent licenses 
using your MapInfo License Server, which is available on the MapInfo Professional DVD. This model 
was developed for customers who have limited access to email or to the Pitney Bowes Software Inc. 
FNO server. Distributed licenses follow a similar activation procedure to other models that are 
handled using your License Server. For instructions on installing the License Server, please see the 
License Server User Guide.

You can also return a distributed license to your License Server if you need to transfer it to another 
computer. For these instructions, see Transferring a Distributed License on page 43.
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Before you start the distributed activation process, make sure you have the following pieces of 
information from your License Server system administrator:

• The correct serial number and activation code
• The License Server machine name 
• The port number for the server

Then you can begin your distributed license installation and activation.

Activating a Distributable License
To activate a distributed license:

1. Make sure your MapInfo License Server is running. Check to see that the server is set up 
properly and contains the appropriate activated licenses.

2. Begin the MapInfo Professional installation process as you would with any other license model.

3. When you are prompted for your serial number and access code, enter the distributed license 
serial number and activation code. Distributed license serial numbers begin with "MID". Click 
Next. The License Server Name and Port dialog box displays.

The port number defaults to 27000 but it can be set by your License Server system 
administrator. Check with the administrator if the port number is not working.

4. Type in your License Server’s (machine) name in the first field and the port number in the second 
or leave the default entry in place. Click Next to continue. The remaining installation prompts are 
the same as in Installing MapInfo Professional in the User Guide.
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5. When you open MapInfo Professional for the first time, one of the following occurs:
• If the application finds the license server, and the serial number, activation code, and port 

numbers are correct, the application opens and the product is activated. 
• If the application did not access the license server, did not recognize the serial number or 

activation code, or did not recognize the port number, an error message displays. We 
recommend that you review these components to ensure that they are correct and/or work 
with your system administrator to review these four pieces of information. Correct the 
erroneous information and begin the activation process again.

After you activate your license, you can review the licensing details in MapInfo Professional by 
selecting Help > About this Product. The About this Product dialog box displays:

The serial number, access code, and licensing details display in this box for future 
reference.

Transferring a Distributed License
You can transfer a distributed license to your License Server, when you want to move the license to 
another computer. 

Before making any hardware changes to your PC (such as disk re-formatting) please 
remember to return your activated license back to Pitney Bowes Software Inc. or to your 
License Server. After your hardware has been changed you may then re-activate your 
license. 

To transfer a distributed license to your License Server:

1. Choose Help > Licensing > Transfer License. The Return distributed license to license server 
dialog box displays.

2. Click OK to transfer the distributed license to the server. After the transfer is complete, a 
confirmation message displays. You can then install MapInfo Professional again on another 
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computer using the same serial number, activation code, license server name and path, and port 
number.
If you have unsaved or open MapInfo table data, the Save Modified Table Data dialog box 
displays. This dialog box helps you save or discard data before you transfer your license to your 
License Server. Click the appropriate option to save or discard this data:
• Click Save to save the open table data
• Click Save All to save the open data in the appropriate data tables 
• Click Discard to close the open table without saving the modified data
• Click Discard All to close the open tables without saving the modified data
After you make your selection in this dialog box, the transfer continues as described above.

After you return the license, the application closes. Since MapInfo Professional is still 
installed on your computer, if you open the application again, the product will attempt to 
activate another distributed license. If the license is not available, you can use the courtesy 
license for the balance of your 30 day trial.
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Workgroup Installations
MapInfo Professional is a desktop application that places user data on a map to 
simplify business analysis for data with a spatial component. This section will 
assist you in setting up a MapInfo Professional network share workgroup that 
allows users to share application data resources (such as coordinate system 
information and templates). Sharing these resources can unify the look of user 
maps and provide consistency in their data.

There are two steps to this Workgroup installation process:

1. System administrators create a shared location for the application 
data files and create a method for users to install MapInfo Professional 
on their own computers.
Before you begin, see Understanding the Workgroup Installation 
Process. To get started, see Beginning a Workgroup Installation 
(System Administrators).

2. Users install the application on their computers, pointing to the shared 
location for their Application Data Files. 
To complete a workgroup installation, go to Completing a Workgroup 
Installation (MapInfo Professional Users)

Topics in this Section:
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Understanding the Workgroup Installation Process
This workgroup installation allows users to retrieve the Application Data Files (such as the 
MAPINFOW.PRJ file and custom symbols) from a shared, network location but install the program 
locally. Using this model, all users can share coordinate system settings, templates, and custom 
symbols.

The workgroup install process is organized in to two steps, so that you can choose to have users:

• install MapInfo Professional from a network location, or 
• install MapInfo Professional from a DVD you create for their use.

If copying the contents of the MapInfo Professional DVD to another location, copy both the MI_PRO 
and Pro_WG folders together to the same place. The workgroup install has a dependency to the 
MI_Pro folder, so both folders must be located together under the same parent directory. If they are 
not located together, then the Workgroup Installer installs only Application Data Files.

If you have any questions or difficulty with this process, please refer to the MapInfo Professional 
User Guide to determine the appropriate Pitney Bowes Software Inc. resource to call.

The workgroup installation process lets a system administrator store commonly used files in 
a shared, central location to accommodate Vista requirements. 

What are the Application Data Files?
Application Data Files are user files that affect the look and basic settings of your MapInfo maps. 
Specifically:

• Custom Symbols
• Graph Support
• Layout Templates
• Configuration files:

• MAPINFOW.ABB (The abbreviations file)
• MAPINFOW.CLR (The colors file)
• MAPINFOW.FNT (The fonts file)
• MAPINFOW.MNU (The menu file)
• MAPINFOW.PEN (The pen file)
• MAPINFOW.PRJ (The projections file)

• Thematic Templates
• WFS and WMS server lists
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Beginning a Workgroup Installation (System Administrators)
To prepare for a Workgroup installation:

1. Inset the installation DVD, click Install Products > MapInfo Professional > MapInfo 
Professional Workgroup. The Workgroup Install screen displays.
Windows 7 users: You may see a prompt for permission to continue. Click Allow or Yes to 
proceed (if you do not respond and the message times-out, the install is unsuccessful).

2. Click Install MapInfo Workgroup. 

3. In the Welcome screen, click Next.

4. In the License Agreement screen, click I agree and then click Next.

All Application Data Files are selected by default. 

5. In the Custom Setup screen, to prevent file sharing of one or more of these file types, click the 
drop-down arrow beside the file type and select This feature will not be available from the list. 

When you choose not to install file(s) to the shared location, MapInfo Professional uses 
the local copy of these file(s) instead. 
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6. Highlight the Application Data Files entry and click Change. The Change Current Destination 
Folder displays. Navigate to the shared location for storing these files and click OK. 
Make sure that this shared location is accessible by all users who need these files. Users 
will need read/write access to add new templates and other custom symbols to share.

When users install MapInfo Professional, these same Application Data Files are also 
stored locally. This allows them to access these files when the shared folder is 
unavailable. For more details, see Completing a Workgroup Installation (MapInfo 
Professional Users) on page 51.

7. Highlight the MapInfo Professional v11.0 Installer entry and click Change to display the 
Change Current Destination Folder dialog box. 

Do one of the following:
• If you want your users to install MapInfo Professional from a DVD you create: 

select a local destination folder and click OK. This installer then copies the MapInfo 
Professional installation files to the local destination folder you selected. At the end of this 
process, you can create installation DVDs for each user from the installation files copied to 
this local folder. You can then distribute these DVDs to each user so they can begin their 
MapInfo Professional installation.

• If you want your users to install MapInfo Professional from a central network location:
select a network location folder and click OK. This installer then copies the MapInfo 
Professional installation files to the network location folder you selected. At the end of this 
process, notify each user of this network destination folder so they can begin their MapInfo 
Professional installation. 

The Custom Setup dialog box displays.

8. Click Next.

9. In the Ready to Install the program screen, click Install. 

10. In the Completed screen, click Finish.
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11. Finally, do one of the following:
• If you saved the installation files locally, create one MapInfo Professional installation DVD for 

each user from the contents of the local folder. Make sure you copy the mode.xml file along 
with the other installation files in that directory.

• If you saved the installation files on the network, notify each user of that network location so 
they can install MapInfo Professional locally.

During this process, you created a MODE.XML file that contains the shared location you set for the 
Application Data Files. When the user opens MapInfo Professional for the first time, the path to the 
shared location is copied from the XML file to the user’s computer registry. If you need to change the 
network location of these files, follow the instructions in Changing the Shared Location after 
Installation on page 52.

IMPORTANT: If your users ask you about the product serial numbers, you can find them on 
the outside of the MapInfo Professional box. Serial numbers are also in a letter inside the 
box, if you need to store them.

The Application Data Files are also stored locally for use when the shared folder is unavailable. The 
next section describes this in more detail.

Completing a Workgroup Installation (MapInfo Professional 
Users)
To complete the workgroup installation, do one of the following:

• If your system administrator has given you a DVD for installation, place this media in the 
appropriate computer drive and follow the MapInfo Professional Installer instructions.

• If your system administrator has placed the MapInfo Professional installer in a network 
location, navigate to that location and follow the MapInfo Professional Installer instructions.

Understanding your Workgroup Installation
When you install MapInfo Professional as part of a workgroup, you share commonly used files with 
the other users in your organization. Workgroups use the same configuration, template, and custom 
symbol files without having to copy them manually. This method supports each workgroup member 
in creating more consistent maps.

As part of your application’s installation process, the MapInfo Professional installer creates a local 
copy of these Application Data Files for your use when the shared location is not available. This is 
very important.

• If the shared location of your Application Data Files is available,
MapInfo Professional saves your template, symbol, and configuration work to the shared 
location. 
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• If the shared location of your Application Data Files is not available, 
MapInfo Professional saves your template, symbol, and configuration work to your local copy of 
these files.

If the shared location is not available when you open MapInfo Professional for the first time, 
an error displays explaining that the application will use the local Application Data Files. You 
can use the instructions in Changing the Shared Location after Installation to select a 
new shared location, if necessary.

Since typically you will access the shared location, this will not be an issue. But if you change any of 
the Application Data Files locally and the shared location becomes available, we recommend you 
copy your work to the shared location. This will ensure that your files are available when you and 
your co-workers need them.

A Note about Graph and Theme Template Files

The search for graph and theme template files is dependent upon the folder setting in the Directory 
Preferences dialog box. If these preferences do not exist in the network location, the application 
searches for files locally.

Changing the Shared Location after Installation
To change the shared location for these files after installation, use the Directory Preferences dialog 
box. Each user in the Workgroup needs to follow this procedure to maintain these shared files.

To change the application data file location for a Workgroup user:

1. Choose Options > Preferences > Directories to display the Directory Preferences dialog box.
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The shared location displays in the Workgroup Directory field. 

2. You can reset the Workgroup folder in one of these ways:

• To set a new shared location, enter a new path in the field provided or click  to select a 
new shared path. 

• To use local files only, clear the Use when searching for application data files check box.

You can use named drives or UNC paths in the Workgroup Directory field.

3. Click OK to confirm your change. The application saves this new path to your registry. Each time 
you open MapInfo Professional after this, the application uses this new path to access the 
Application Data Files.
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Silent Installation Procedures for System Administrators
Silent installations allow you to repackage MapInfo Professional for deployment within your 
company so your users do not have to enter user- or company-specific information, path 
information, a serial number, or an access code. 

You may also be interested in reviewing the MapInfo Professional Workgroup Guide for file 
sharing to use this installation model for deploying MapInfo Professional.

The MapInfo Professional installation setup.exe indicated in the steps below can be found on the 
installation DVD (d:\) in this directory:

\Install\MI_PRO\DISK1

In general, the silent installation process goes like this:

1. Place the installation DVD in the target computer’s disk drive.

2. From the command line on the target computer, type: 
"[drive and path to setup exe]:setup.exe" /s /v"[Parameters for MSI]"

where PARAMETERS for MSI are the parameters you set to populate the msiexec .
For example:
"d:\Install\MI_PRO\DISK1\setup.exe" /s /v"/qb
INSTALLDIR=\"[PathTo]\MapInfo\OtherThanStandard\Professional 11.0\"
USERNAME=\"MyUser\" 
COMPANYNAME=\"MyCompanyName\"
PIDKEY=MySerialNumber 
ACCD=MyAccessCode"

The command line parameters for the installer can not contain "~","/". 

The parameter /qb tells the msiexec command to launch the install with a basic interface. That does 
not require any user action and allows the user to respond to the UAC in Windows 7.

There should be no space in between Variable=Content. A space is used as a separator in between 
parameters.

Parameters for user information:

• USERNAME=User Name
• COMPANYNAME=Company Name

Parameters for installation target information:

• INSTALLDIR=Install Directory
• CRYSTALRINST=False 

Use this parameter to decline the installation of Crystal Reports, installed by default.
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Parameters for licensing information:

• PIDKEY=Serial Number
• ACCD=Access Code
• LSNAME=License Server Name
• LSPN=License Server Port Number

Parameters for activating node lock and distributed licenses silently:

• ACTLIC=True 
For silent automatic NODE LOCK and DISTRIBUTED activate licenses.

• RETLIC=True
For silent return licenses.

• LICLOG=Filename for log files
• BORROW=#days or True 

If no specific  number of days are entered, True is a valid input and results in a # of days.
• SDRLYN=False 

Use this parameter to see no license transfer dialog when the user uninstalls. The license 
stays on the system if not RETLIC=True.

Parameters ACTLIC and RETLIC are False by default. 

Parameter for English language setting:

• LANGCS=ENUS or ENUK 
The default is based on the computer’s region options format setting. If this is set to anything 
other than US english, ENUS, then UK english, ENUK, is set.

For concurrent licenses the parameters for the license server name and license server port number 
must also be included: 

1. Place the installation DVD in the target computer’s disk drive.

2. From the command line on the target computer, type: 
"d:\Install\MI_PRO\DISK1\setup.exe" /s /v"PARAMETERS"
where PARAMETERS are the parameters you set to populate the msiexec.
For example:
"d:\Install\MI_PRO\DISK1\setup.exe" /s /v"/qb 
INSTALLDIR=\"[PathTo]\MapInfo\OtherThanStandard\Professional 11.0\""

All of the Microsoft supported parameters for working with the MSIEXEC command are 
documented on the Microsoft web site. Search the term "MSIEXEC command line 
parameters" to find this detailed information.

Look for the type of installation you want to perform from the options below and follow the 
corresponding instructions. In each of the install scenarios described below, the serial number and 
access code parameters are given in the following format: 

• PIDKEY=MI##############

• ACCD=######
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Substitute the appropriate serial number and access code when you perform the silent install.

Installing Silently on Windows 7
You cannot perform a completely silent install of MapInfo Professional on Windows 7 computers. 
The command-line options /q and /qn do not work on Windows 7. These options turn off the user 
interface during the installation, which suppresses the Windows 7 User Access Control (UAC). 
Users must interact with the UAC to provide the necessary credentials to run the installation as an 
administrator. If the user interface is turned off, the installation is terminated without warning 
because the UAC cannot gather the appropriate credentials.

To work around the problem, use the /qb option in the command line when you run the silent install. 
This option gives the installation a basic user interface and allows the UAC to display on the screen. 

To perform a silent install on a Windows 7 computer using the /qb option: 

1. Place the installation DVD in the target computer’s disk drive.

2. From the command line on the target computer, type: 
"d:\Install\MI_PRO\DISK1\setup.exe" /s /v"/qb USERNAME=\"MyUser\"
COMPANYNAME=\"MyCompanyName\"PIDKEY=MI############## ACCD=######" 

where: 
PIDKEY=MI############## is the product serial number
ACCD=###### is the access code

3. When User Access Control displays on the screen, click Allow. 

For concurrent licenses, the license server name and port number parameters must be included: 

LSNAME="LicenseServerName"
LSPN="LicenseServerPortNumber"

Substitute the appropriate license server name and port number when you perform the silent install.

Activating and Returning Licenses Silently
Information Technology engineers may want to activate or return MapInfo Professional node-locked 
or distributed licenses silently, using a log file for reports. The return process described in this 
section can also return a borrowed license to the server. This section describes these processes.
MapInfo Professional 11.0 57 Install Guide



Chapter 5: Silent Installation Procedures
Activating and Returning Licenses Silently
Activating a Node-Locked or Distributed License Silently
A node-locked license is a permanent license that originates from the Pitney Bowes Software Inc. 
FNO server. A distributed license is a permanent license that originates from a License Server 
owned by your company. This same process works for both types of license activations.

Before making any hardware changes to your PC (such as disk re-formatting) please 
remember to transfer your activated license back to Pitney Bowes Software Inc. or to your 
License Server. After your hardware has been changed you may then re-activate your 
license. 

To activate a node-locked or distributed license silently:

1. Collect the information you need to install MapInfo Professional on the client’s computer, 
including the appropriate serial number and access code. For distributed licenses, you also need 
to enter your license server’s name and port number.

2. From the client computer’s command line, type the following and press Enter:
<path to application>\MapInfow.exe -ActivateLicense c:\mylog.txt
where c:\mylog.txt is the path and name of a log file that tracks the details (successes and 
errors) of the activation process. The log file is optional.

If you do not specify a log file, as in the example below, the application creates a file 
called activatelicense.log in your temp folder.

<path to application>\MapInfow.exe -ActivateLicense
One of these events occurs:
• If the serial number begins with MID, the application attempts to activate a distributed license 
• If the serial number begins with MIN, the application attempts to activate a node-locked 

license 
• There was an error in the activation process that requires correcting
To view the results of the activation process after it is complete, open the log file with any text 
editor. Possible log file messages include:

Message What to Do

Your node lock license was activated 
successfully.

The activation process is complete.

Your distributed license was activated 
successfully.

The activation process is complete.

A license was already activated. No new 
license is activated.

The activation process is complete.
MapInfo Professional 11.0 58 Install Guide



Chapter 5: Silent Installation Procedures
Activating and Returning Licenses Silently
Returning a License Silently
Before making any hardware changes to your PC (such as disk re-formatting) please remember to 
return your activated license back to Pitney Bowes Software Inc. or to your License Server. After 
your hardware has been changed you may then re-activate your license. 

You can return a node-locked, borrowed, or distributed license to the Pitney Bowes Software Inc. 
FNO or your License Server using these instructions:

• From the client computer’s command line, type the following and press Enter:
MapInfow.exe -ReturnLicense c:\mylog.txt 
where c:\mylog.txt is the path and name of a log file that tracks the details (successes and 
errors) of the return process. The log file is optional.

If you do not specify a log file, as in the example below, the application creates a file 
called returnlicense.log in your temp folder.

<path to application>\MapInfow.exe -ReturnLicense

One of these things occurs:

• The license is returned to the Pitney Bowes Software Inc. FNO server or your License Server
• An error occurs preventing the return of the license

To view the results of the return process after it is complete, open the log file with any text editor. 
Possible log file messages include:

One of the license components is incorrect 
or missing 

Check the log file to see which component (serial 
number, activation code, or for distributed licenses, 
server name or port number) is missing or incorrect.

No license was activated as your license 
appears to be a concurrent or borrow type 
license.

Check your License Server and to review the type(s) 
of licenses that are available. Your client may need 
to get a concurrent or borrow a license instead. See 
Starting and Activating MapInfo Professional on 
page 27 for more details on these license types. 

Message What to Do

Message What to Do

Your distributed license was returned 
successfully to the license server 
<ServerName>.

The return process for the distributed license is 
complete.

Your borrowed license was returned 
successfully to the license server 
<ServerName>.

The return process for the borrowed license is 
complete.
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Uninstalling Silently
To perform a silent uninstall of MapInfo Professional 11.0:

• From the command line on the target computer type: 
msiexec.exe /x{CADEAC59-9D63-4E13-A22B-D6BFBFB30174}/q

Running this command only uninstalls MapInfo Professional 11.0. It does not uninstall a previous 
version of MapInfo Professional. It does not uninstall MapInfo ProViewer, MapInfo Runtime, or 
MapBasic.

The uninstall key is unique to each version of MapInfo Professional. To silently uninstall an 
older version of MapInfo Professional, you would need to use its product code (uninstall key). 
These keys are in the regestry at 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\

Your node license was returned 
successfully to Pitney Bowes Software Inc..

The return process for the node-locked license 
is complete.

If returnable license was found but the 
system could not return it, the system posts 
an error message describing the error.

Check the log file for the details of the error and 
correct the problem either on the client’s 
machine or in your License Server, as needed.

No license was returned as no distributed 
license was found.

Check the About this Product dialog box to 
ensure that the license is distributed and try the 
return process again.

No license was returned as no server 
license was found.

Check your License Server to make sure the 
license is available and the server is up. Then 
try the return process again.

No license was returned as no node- lock 
license was found.

Check the About this Product dialog box to 
ensure that the license is node locked and try 
the return process again.

Message What to Do
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Controlling Advanced System Settings 
MapInfo Professional has some advanced system settings that cannot be configured through a 
dialog box. These settings allow you to control several low-level, technical aspects of how MapInfo 
Professional runs. Most users do not need to worry about these advanced settings.

For example, MapInfo Professional has a Dynamic Data Exchange (DDE) time-out setting, which 
controls how long MapInfo Professional tries to communicate with other applications during DDE 
communications. If you run a MapBasic application, and that application encounters time-out errors 
during DDE, you may want to increase the DDE time-out setting. To modify one of MapInfo 
Professional’s advanced system settings (such as the DDE time-out setting), use this procedure.

Modifying the Windows Registry

MapInfo Professional stores system settings in the Windows registry. To edit the Windows XP 
registry, use the REGEDT32 program.

CAUTION: Be very careful when editing the registry; damaging the registry can cause 
serious problems in your operating system.

For example, to set MapInfo Professional’s Dynamic Data Exchange (DDE) time-out setting, locate 
the following key in the registry:

HKEY_LOCAL_MACHINE\SOFTWARE\MapInfo\MapInfo\Common

Within that key, edit the DDeTimeout value. If there is no value by that name, create a new value of 
type string, and assign the name DDeTimeout to the value. Set the value’s data to be a number, 
representing the number of milliseconds (for example, enter 30000 to specify a time-out of 30 
seconds). For more on editing the registry, see the online help for REGEDIT or REGEDT32.

Descriptions of Advanced Registry Settings 
This section describes advanced settings that are stored in the registry. 

Set Polygon Mode or Subdivide Printing in MapInfo Professional by selecting Options > 
Preferences > Output Settings.

DDeTimeout = number
This setting controls MapInfo Professional’s time-out setting in DDE conversations where MapInfo 
Professional is the client (the application that initiates a conversation). The number represents 
milliseconds. The default value is 10,000 milliseconds (ten seconds). If you run a MapBasic 
application that attempts to initiate a DDE conversation, but the conversation fails because the 
server application does not respond within the time-out period, you may need to increase the 
DDeTimeout number.

MaxFiles = number
This setting must be an integer from 10 to 507, indicating how many files MapInfo Professional can 
open simultaneously. This setting does not limit the number of tables you can open, but it does limit 
the number of tables you can edit at one time (the number of tables that have unsaved edits). The 
default value is 29. If you need to work with more files simultaneously, set number to 507.
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MaxORACLETILES = number
The number is 0 (zero) or 1 (one). This setting applies when working with Quad-Tree indexed Oracle 
tables from versions of Oracle that are older than version 10. A value of 0 (zero) causes MapInfo 
Professional to disable spatial query and return all records using client-side clipping. A value of 1 
(one) or more specifies the maximum number of tiles to use per geometry to refine a spatial query. 
When creating a spatial index using the old Quad-Tree method, you specify the number of tiles to 
use. This value lets you further refine the search by specifying the max number of tiles to use.

Improving Performance for MapInfo Professional 

To improve MapInfo Professional’s performance, you can increase the speed of the processor in the 
machine. A video accelerator card will increase the speed of the redraw. It will not speed up the 
initial draw of the map, but all subsequent redraws will be faster. A faster disk cache will also 
improve performance, as will adding memory.

Controlling the Location of Application Data Files
By default, the setup program for MapInfo Professional installs application data files to locations that 
make sense for the typical user. After installing the product, the user is free to move one or more of 
the application data files to another predefined location and MapInfo Professional will find that file. 
For example, the administrator of a machine might move MAPINFOW.PEN from the per user area 
(its default location) into the install directory so all users on that machine will share the same set of 
pens. For IT personnel responsible for a large number of MapInfo Professional installs, it is not 
practical to manually move application data files to realize the desired configuration. 

To solve this problem, create a setting file, MODE.INI, to specify the location of application data files 
prior to installing MapInfo Professional. 

1. Copy the installation files to a read-write location.

2. Create a MODE.INI file in the root directory of the installer. 

1. Open MODE.INI into any text editor.

2. Edit MODE.INI, modifying the code associated with the application data file/folder whose 
location you wish to change.

3. Install MapInfo Professional.

Code Description Location

1 per user, roaming <Current User>\Application Data

2 per user, not roaming <Current User>\Local Settings\Application Data

3 per machine <All Users>\Application Data

4 program directory <Install Dir>
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The following is a list of predefined locations for application data files supported by MapInfo 
Professional, and the corresponding numeric code to be used in MODE.INI.

The following is a list of application data files/groups and their default locations:

* The file called WFSWMS.XML is a representation of three separate files:

• MICSWServers.xml – this file is related to the MetaData Catalog Browser tool
• MIWFSServers.xml – this file is related to the list of WFS servers for File > Open Web Services > 

WFS feature
• MIWMSServers.xml – this file is related to the list of WMS servers for File > Open Web Services 

> WMS feature

MODE. INI File Example

Create a text file with the following syntax:

GraphSupport = 1
CustSymb = 1
ThmTmplt = 3
LayoutTemplate = 1
MapInfow.clr = 1
MapInfow.fnt = 1
MapInfow.pen = 1
MapInfow.abb = 4
MapInfow.prj = 4
MapInfow.mnu = 4
WFSWMS.xml = 1 

Filename Default Location

CustSymb per user, roaming

GraphSupport per machine

LayoutTemplate per user, roaming

MapInfow.abb program directory

MapInfow.clr per user, roaming

MapInfow.fnt per user, roaming

MapInfow.mnu program directory

MapInfow.pen per user, roaming

MapInfow.prj program directory

ThmTmplt per user, roaming

WFSWMS.xml* per user, roaming
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Installation Issues
Installation Issues

The MapInfo PDF Printer Driver did not Install
It is possible that the MapInfo PDF Printer driver may not install when:

• Your IT department has a policy to disallow printer installations.
Contact your IT department to check if there is such a policy in place. If there is, then uninstall 
MapInfo Professional and have them temporarily allow printer installation on your machine while 
you reinstall MapInfo Professional.

• Your anti-malware or anti-spyware is turned on during the installation.
Uninstall MapInfo Professional. Contact your IT department to temporarily stop the anti-malware 
or anti-spyware on your machine while you reinstall MapInfo Professional.

Using .MSI file on the Installation DVD does not create a Warning 
Message

If performing a silent installation of MapInfo Professional, use the setup.exe file located in the 
Install\MI_PROD\DISK1 folder on the MapInfo Professional DVD, and not the "MapInfo Professional 
11.0.msi" file. The .msi file does not install necessary prerequisites. Using the .msi file to install 
MapInfo Professional, instead of using setup.exe, causes MapInfo Pro to install incorrectly. 

Error Messages

Message: Unable to launch MapInfo Professional
If the .NET install is canceled or interrupted when installing MapInfo Professional, then after the 
second attempt to install MapInfo Professional it does not launch and displays an "Unable to launch 
MapInfo Professional" message.

MapInfo Professional requires .NET 4.0, so its install wizard installs .NET before it installs MapInfo 
Professional. If the .NET install is interrupted or canceled, then the MapInfo Professional install 
wizard cancels. When running the MapInfo Professional install wizard a second time, it assumes 
that .NET is installed on the machine (even though it did not install) and the MapInfo Professional 
software is unable to launch and run. The first attempt to install .NET leaves a registry key set on the 
machine, so any subsequent installs do not attempt to install .NET again—the MapInfo Professional 
install wizard thinks that .NET is already installed.

To correct this issue, and install .NET to the machine, you must download the Microsoft .NET 
Framework 4.0 from Microsoft’s website and install it.
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Error Messages
Message: The feature you are trying to use is on a network resource that 
is unavailable.

If you see the following message, then the install was run on Windows 7 without elevated privileges.

The feature you are trying to use is on a network resource that is unavailable.

Re-run the install using elevated privileges, either:

• Right-click the executable file and select Run as Administrator from the popup menu to install 
using elevated privileges. A prompt for permission to continue displays. Click Allow or Yes to 
proceed (if you do not respond and the message times-out, then the install is unsuccessful).

• Have your System Administrator re-run the install, because your account does not have the 
necessary privileges.
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